
 

Getting Started Guide



 

Notice

 

Every effort has been made to supply complete and accurate information. 
However, Palladium Interactive, Inc. assumes no responsibility for its use, nor 
any infringement of patents or other rights of third parties which would result.  

Copyright ©1997 by Palladium Interactive, Inc.

World-wide rights reserved.  Except for your own personal use, no part of this 
publication may be stored in a retrieval system, transmitted, or reproduced in 
any way, including but not limited to photocopy, photograph, magnetic or 
other record, without the prior agreement and written permission of Palladium 
Interactive, Inc.

ROOTS, ROOTS IV, ROOTS V, and Ultimate Family Tree are trademarks of 
Palladium Interactive, Inc.

All other trademarks acknowledged.

The method used to format footnotes in Ultimate Family Tree is covered by 
U.S. Patent 5,097,418 and is licensed to Palladium Interactive, Inc. by 
COMMSOFT, Inc.

All Ultimate Family Tree specifications are subject to change without notice.

Printed in the United States of America.



 

i i i

 

Contents

 

Section 1: Ultimate Family Tree for Windows  . . . . . . . . 1

 

Help is Always at Your Fingertips  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2
Getting Ready to Install . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3

 

System Requirements 3, Make Sure You Have Everything You Need 3, 
Customer Registration 3

 

Installing Ultimate Family Tree . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3

 

Installation Instructions 4, On-Line Guide and Browser Setup 7, 
Reinstalling Ultimate Family Tree 7, Creating an Ultimate Family Tree 
Icon in Windows 95 8

 

Starting Ultimate Family Tree . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9

 

Ultimate Family Tree Desktop Display 9, Creating a New Project 11

 

Getting Familiar with Ultimate Family Tree . . . . . . . . . . . . . . . . . . . . . . . 14

 

Menu Bar 14, Function and Shortcut Keys 15, Toolbar 15, Reserved 
Characters 16, Rich Text Format Printing 16, International Characters 17

 

Quick Start Tutorial . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17

 

Creating an Individual Record 18, Creating a New Record for Yourself 18, 
Adding Parents 19, Creating a Birth Event 19, Creating a Marriage Event 
and Adding a Spouse 19, Creating Other Events 20, Adding Evidence, 
Text, and Other Information 21, Adding a Child 22, Adding a Sibling 23, 
Viewing Ancestors in the Family Tree (Pedigree) Window 24, Viewing a 
Family Group 24, Viewing an Individual Summary 25, Deleting a Project 26

 

Did You Know? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27

 

Go Menu 27, The New Spouse Button 27, Text and Evidence Status 
Boxes 27, Using Undo 28, Date Preferences 28, Graphics Display 28, 
Editing Place Names 29, Finding Individuals 29, Using Existing Records 
for Parent and Spouse Fields 30



 

i v

 

Section 2: Ultimate Family Tree for Macintosh  . . . . 31

 

Help is Always at Your Fingertips . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32
Getting Ready to Install  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32

 

System Requirements 32, Make Sure You Have Everything You 
Need 33, Customer Registration 33

 

Installing Ultimate Family Tree . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33

 

Installation Instructions 33, On-Line Guide and Browser Setup 34, 
Reinstalling Ultimate Family Tree 34

 

Starting Ultimate Family Tree  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35

 

Ultimate Family Tree Desktop Display 36, Creating a New Project 37, 
Opening an Existing Project 39

 

Getting Familiar with Ultimate Family Tree  . . . . . . . . . . . . . . . . . . . . . 40

 

Menu Bar 40, Shortcut Keys 41, Reserved Characters 42, Rich Text 
Format Printing 42, Ultimate Family Tree and WindowShade 42

 

Quick Start Tutorial  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 43

 

Creating an Individual Record 43, Creating a New Record for 
Yourself 43, Adding Parents 44, Creating a Birth Event 45, Creating a 
Marriage Event and Adding a Spouse 45, Creating Other Events 46, 
Adding Evidence, Text, and Other Information 47, Adding a Child 48, 
Adding a Sibling 49, Viewing Ancestors in the Family Tree (Pedigree) 
Window 49, Viewing a Family Group 50, Viewing an Individual 
Summary 50, Deleting a Project 52

 

Did You Know?  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52

 

Go Menu 52, Changing Parents 53, The New Spouse Button 53, 
Changing a Spouse in a Marriage Event 54, Text and Evidence Status 
Boxes 54, Using Undo 55, Date Preferences 55, Graphics Display 55, 
Editing Place Names 55, Finding Individuals 56, Using Existing Records 
for Parent and Spouse Fields 57



      
Section 1:

Ultimate Family Tree 
for Windows
y to 
 
ur 

w-
e 

r 
ree, 
g 
i-

age 
gy 
ndi-
ts 
red 

 
al 

ur-
o 
 has 
Welcome to Ultimate Family Tree™ and the exciting world of multimedia 
genealogy. Genealogy is the pursuit of knowledge about our past. It’s a wa
look at our families in order to better understand ourselves. With Ultimate
Family Tree, you can view the past in ways never dreamed possible by yo
ancestors.

You can store and display video and audio recordings, pictures, dra
ings, and scans of important documents. You can create and organize slid
shows with descriptions and music, and play them back on your compute
screen. You can even scan your own photos directly into Ultimate Family T
edit, and modify them. Taking advantage of Object Linking and Embeddin
(OLE), Ultimate Family Tree provides nearly limitless possibilities for mult
media presentations.

Ultimate Family Tree’s easy-to-use data entry screens, Instant Web P
Publisher, spell checker, and online capabilities are firsts for any genealo
software. Using Ultimate Family Tree, you can document events in each i
vidual’s life by drawing from a library of approximately 200 predefined even
or by creating your own. Fundamental information for each person is ente
through Ultimate Family Tree’s powerful Individual Record window.

The online functions provided by Ultimate Family Tree are its most 
exciting feature. It’s possible to connect directly to the program’s exclusive
website and converse with research experts, download useful genealogic
information, and upload your own family history web page.

Soon you will be entering your own information, creating beautiful jo
nals, and experiencing the voices and pictures of loved family members. T
help you get started with your genealogical research Palladium Interactive
furnished an on-disk Beginner’s Guide to Genealogy in Adobe Acrobat Reader 
1
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format. The Beginner’s Guide to Genealogy is called BEGINNER.PDF and is 
found in the \DOCS directory of the Ultimate Family Tree CD-ROM. Also i
this directory you will find complete user’s guides in PDF format.

Help is Always at Your Fingertips
Ultimate Family Tree provides the following help:

• The Ultimate Family Tree Getting Started Guide

• The Ultimate Family Tree User’s Guide on CD-ROM

• The Ultimate Family Tree Web Site http://www.uftree.com

• Online Help—an online reference guide that includes context sensit
help, extensive cross referencing, troubleshooting assistance, a guid
error messages, answers to frequently asked questions, and a gloss

• Technical support

If you have questions about any aspects of the program, follow these step

1. Check the Table of Contents or the Index of the Ultimate Family Tree 
User’s Guide for the subject you need help with, or from the Ultimate
Family Tree menu, choose Help followed by Help Topics. In the resu
ing window, locate on-screen information about your topic.

2. See “Troubleshooting” in Appendix A of the Ultimate Family Tree 
User’s Guide and online Help for answers to common problems.

3. Contact Ultimate Family Tree Technical Support:

• FAX 812-829-1020

• Mail 743 E. Franklin Street, Suite B, Spencer, IN 47460

• CompuServe GO GENSUP

• Internet (email) pifamily@palladiumnet.com

• Telephone 812-829-4405 (8 AM–10 PM CST, M–F)

If you call for technical support, please call while you’re at your com
puter. Technical support is offered for questions or problems using Ultima
Family Tree, but not for assistance or advice with Microsoft™ Windows™
genealogical research. If you need assistance with Windows, please cont
Microsoft Corporation or consult your Microsoft Windows User’s Guide.
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Getting Ready to Install

 

System Requirements

 

Ultimate Family Tree for Windows 3.1 (80386 CPU, 25 MHz) and Window 95 
(80486 CPU, 33 MHz) is designed for systems having 8 MB or more Random 
Access Memory (RAM), and 16 MB is recommended. You need at least 20 
MB of free hard disk space before installing Ultimate Family Tree. The files 
supplied with the program require approximately 15 MB of hard disk space. 
An additional 5 MB of disk space is required (approximately 2.5 MB for data 
and 2.5 MB for temporary work space) for every 1000 individuals you add. 
The program can use a TWAIN-compatible device such as a scanner, a sound 
card, and other multimedia features. Additional hard disk space may be 
required to use multimedia features fully. A modem is required to use the Go 
Online feature.

 

Make Sure You Have Everything You Need

 

Your Ultimate Family Tree package should include:

• This guide

• Registration card

• Browser setup instructions

• Upgrade instructions

• Ultimate Family Tree CD-ROM

 

Customer Registration

 

Fill out and mail the enclosed registration card immediately. This card quali-
fies you to receive free technical support and notification of upgrades.

 

Installing Ultimate Family Tree

 

Ultimate Family Tree can be installed as a separate program or as an update to 
ROOTS IV, Visual ROOTS, or Family Gathering. If you use any of these pro-
grams, you need to decide whether to install Ultimate Family Tree as an 
update or in a separate directory. If you have no other ROOTS or Family Gath-
ering program, simply follow the installation instructions below. If, however, 
you are using one of these programs, we recommend that you install Ultimate 
Family Tree as an update.
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If you choose to install Ultimate Family Tree as an update to Visual 
ROOTS, the program files for Visual ROOTS will be deleted after Ultimate
Family Tree has been installed; however, all data files will remain intact. Y
can proceed to use Ultimate Family Tree without additional consideration

If you install Ultimate Family Tree as an update to ROOTS IV, the Ul
mate Family Tree library files will be installed in the same directory as the
ROOTS IV library files, resulting in two sets of library files. When you insta
Ultimate Family Tree as an update to ROOTS IV, the ROOTS IV program fi
are deleted, the data files remain intact, and the library files retain their 
ROOTS IV names. If you start a new project, you have the option of choos
to create an Ultimate Family Tree or ROOTS IV project. If you choose to c
ate a new Ultimate Family Tree project, the Ultimate Family Tree library fi
are used. If you choose to create a ROOTS IV project, your existing ROO
IV libraries, containing the places and sources entered in ROOTS IV, are u
If you have been using ROOTS III or another genealogy software program
you will import your ROOTS III or GEDCOM file, and the Ultimate Family 
Tree library files are used.

If you are currently using ROOTS IV and want to have only one set 
library files, you should install Ultimate Family Tree in a separate director
create Event GEDCOM files of your existing data, and import them direct
into Ultimate Family Tree.

Note  ROOTS IV library files are named X_PLBOOK.*, 
X_SOBOOK.*, X_ELBOOK.*, and so on. ROOTS V, Visual ROOTS,
Family Gathering, and Ultimate Family Tree library files are named 
V_PLBOOK.*, V_SOBOOK.*, V_ELBOOK.*, and so on.

Note  When creating a new ROOTS IV project, Ultimate Family Tre
looks for ROOTS IV library files in the \ROOTS4\LIBRARY directory.
If the ROOTS IV library files are located in a directory other than 
\ROOTS4\LIBRARY, you cannot create a new project using those fil
in Ultimate Family Tree. If you want to continue to use ROOTS IV 
library files for new projects and ROOTS IV is installed in a directory
other than ROOTS4, install Ultimate Family Tree as a standard insta
tion and not as an update to ROOTS IV.

Installation Instructions
To install Ultimate Family Tree as a new program or as an update to Visua
ROOTS or Family Gathering, follow these steps:

Note  If you have any problems with the installation, see Installatio
Troubleshooting in the Ultimate Family Tree User’s Guide. Please 
ensure that you have disabled all virus scanning software, screen sa
and any other software which may interfere with the installation.
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1. Start Windows

2. Insert the CD-ROM in your CD drive.

3. If you are running Windows 3.x, choose File from the Program Man-
ager, and then Run. If you are running Windows 95, choose Start, a
then Run from the task bar.

4. Type d:\setup (substitute the correct drive letter for your own CD-ROM
drive). Click OK.

5. The Ultimate Family Tree install program begins. It is strongly recom
mended that you close all running Windows applications before pro-
ceeding. Click Cancel to stop the setup program and close any runn
applications or click Next to continue.

6.  The Setup program will search for installed components of Visual 
ROOTS, ROOTS IV, or Family Gathering. The installation program w
ask you if you want to update an existing program or install Ultimate
Family Tree in a new directory.

7. Click Yes to update the program or No to install Ultimate Family Tree
a separate program.

Note If you install Ultimate Family Tree as an update to ROOTS IV
Visual ROOTS, or Family Gathering, the program files for those pro-
grams will be deleted after Ultimate Family Tree has been successfu
installed.

8. If you chose No, the default directory is C:\UFT. Click Browse to spe
ify a different directory.

Note If you specify a directory that doesn’t exist, a message appea
stating that fact. Click Yes to continue the installation. Do not specify a 
directory which contains ROOTS IV, Family Gathering, Ultimate Fam
ily Tree, or Visual ROOTS unless you chose one of the update option
the previous window. If you do, Ultimate Family Tree will not be 
installed as an update to that program. The program files for the exis
program will remain after Ultimate Family Tree has been successful
installed. No data files will be overwritten; however, important contro
files for the other program will be overwritten.

9. Choose one of the following options and click Next:

• Typical — Installs the program plus the Kennedy sample project.

• Minimum — Installs Ultimate Family Tree and library files without the
Kennedy sample project.



 

6

 

S

 

ECTION

 

 1: U

 

LTIMATE

 

 F

 

AMILY

 

 T

 

REE

 

 

 

FOR

 

 W

 

INDOWS

   

 

  

om 

  

 

lti-
 to 

  

e 
ou 
ata 
e 

    

, 
ing 

 7.

, 

ys-
• Custom — Allows you to install selected files. The Custom option 
should be used for reinstallation only.

10. You are prompted to select a program folder or group. The default is
genealogy. You may enter a folder or group name and click Next.

11. Setup tells you that it has enough information to start copying files fr
the CD-ROM. Click Next to continue. Setup installs Ultimate Family 
Tree, Ultimate Family Tree Gateway, Family Album Maker, Records 
Requester, the Gazetteer, and Browser Setup.

Note If you need to go back to a previous step for any reason, click
Back to return.

12. If you are installing over a previous version of Family Gathering or U
mate Family Tree, the install program will ask you whether you wish
retain or copy over the following:

• Existing Spell Checker files

• Existing Event Choice lists

• Existing report configurations

• Existing Task Lists

• Existing right mouse setups

Note  If previous REVENT, Spell Checker, or Event Choice files ar
found, you are prompted to install new files or use existing ones. If y
have added words to the Spelling Dictionary, added new REVENT d
in ROOTS IV, or added new event types in Visual ROOTS or Ultimat
Family Tree, do not install the newer files.

Note Answering no will replace these files with program default files
and you will lose any changes you may have made. Before reinstall
over a previously installed version of Family Gathering or Ultimate 
Family Tree, please read “Reinstalling Ultimate Family Tree” on page

13. Once all of the files have been updated or installed, the Readme file
containing up-to-date information not included in the manual, is dis-
played.

14. Close the Readme file and click Finish to end the installation.

15. In the new Genealogy Program Group, up to six icons are created, 
depending on the installation options you chose and the operating s
tem you are using.
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• Browser Setup — Identifies a browser for Ultimate Family Tree.

• Ultimate Family Tree — Starts Ultimate Family Tree.

• Kennedy Sample — Starts Ultimate Family Tree with the sample 
Kennedy project.

• Uninstall Ultimate Family Tree — In Windows 3.x, an additional icon is 
created to uninstall Ultimate Family Tree from your system. In Win-
dows 95, Uninstall is located in the Control Panel under Add/Remov
Programs. Note that Uninstall cannot remove any files created or m
fied after installation such as Project or Library files.

• Ultimate Family Tree Editor — Opens the powerful Windows word pro
cessor supplied with Ultimate Family Tree.

• Readme file — Opens a text file with last-minute information not avail
able when the manual was created.

On-Line Guide and Browser Setup
In order to use the on-line features of Ultimate Family Tree, you need to r
the Browser Setup program installed with Ultimate Family Tree. Browser 
Setup looks for an existing browser on your system and either configures
mate Family Tree to use this browser, or lets you install the Netscape bro
from the Ultimate Family Tree CD-ROM. Browser Setup will not change yo
browser configuration in any way.

To use Browser Setup, exit Ultimate Family Tree and follow the 
Browser Setup instructions in the On-Line Guide included separately in th
Ultimate Family Tree box.

Reinstalling Ultimate Family Tree
To reinstall Ultimate Family Tree, follow these steps.

1. Start Windows.

2. Insert the CD-ROM in your CD drive. 

3. If you’re running Windows 3.x, choose File from the Program Manage
and then Run. If you’re running Windows 95, choose Start, and then
Run from the task bar.

4. Type d:\setup (substitute the correct drive letter for your own CD-ROM
drive). Click OK.

5. In the Welcome dialog, read the information and click Next.
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6. Setup will search for installed components and display a message i
existing Ultimate Family Tree installation is found. Click OK.

Note  The directory in which the Ultimate Family Tree executable fi
was found is displayed in the Destination Directory box. Click Brows
to change to another directory.

7. Three installation options are available. Select Custom and click Ne

8. Deselect the options you do not want reinstalled with Ultimate Fami
Tree.

9. Highlight Ultimate Family Tree by clicking once on the program nam
Notice that the Change box turns from gray to black. Click Change t
select the modules of Ultimate Family Tree that you wish to reinstall

Note  If you have added your own images, do not select Image Lib
ies. Choosing Program Files and Printing Support Files reinstalls pr
gram files only and will not affect any data files. If you have added yo
own images, places, or sources, do not select the image libraries, p
libraries, or source libraries. Intstalling these options will destroy you
data by installing default libraries.

Creating an Ultimate Family Tree Icon in Windows 95
In Windows 95, Ultimate Family Tree can be accessed from the Start, Pro
grams list. If you want to create an Ultimate Family Tree icon on the Windo
95 Desktop, follow these steps:

1. Click the right mouse button on the Desktop.

2. Choose New.

3. Choose Shortcut.

4. Click Browse.

5. Change to the \UFT directory and choose UFTREE (UFTREE.EXE)

6. Click Open. UFTREE.EXE appears in the Command line.

7. Click Next.

8. Type Ultimate Family Tree in the name field and click Finish.
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Starting Ultimate Family Tree
Before starting Ultimate Family Tree you should be familiar with Microsoft
Windows, have Ultimate Family Tree installed on your computer, and hav
your printer correctly installed and configured under Windows. If your prin
is not set up, consult your Windows manual for assistance.

To start Ultimate Family Tree, follow these steps:

1. Start Windows.

2. Open the Genealogy program group (or whichever group or folder in
which you installed Ultimate Family Tree).

3. Double-click the Ultimate Family Tree icon. If you are starting Ultima
Family Tree for the first time, the Ultimate Family Tree Title window 
appears, followed by the Welcome window with a message stating U
mate Family Tree did not find a project. You are offered the following
options:

• New — Begins a new project

• Open — Opens an existing Ultimate Family Tree project

• Exit — Leaves Ultimate Family Tree

Ultimate Family Tree Desktop Display
Ultimate Family Tree provides two styles for desktop display. They are Gra
ics and Windows Colors. Graphics provides wallpaper on the desktop and
windows. Windows Colors establishes desktop and window colors from th
Windows Control Panel. If your monitor is set to 16 colors, the Windows 
Colors are used.

Figure 1-1: Welcome Window
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Using the graphics display can reduce the performance of the progr
If you suspect that Ultimate Family Tree is running more slowly than it 
should, refer to page 196 for instructions on how to switch to the Windows
color mode. Choose the colors option for Ultimate Family Tree according 
your personal preference and system performance.

Figure 1-2: Ultimate Family Tree with Graphics Desktop Display

Open Miscellaneous,
Medical, and Multimedia
windows

Go to top of event list
Move up one event
Move down one event
Go to bottom of event list

Figure 1-3: Ultimate Family Tree with Windows Colors 
Desktop Display

Click to edit

Click to edit
event evidence

event text
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Note

 

The illustrations in this User’s Guide use the Windows Colors 
option to display screen shots.

 

Creating a New Project

 

To start a new project in Ultimate Family Tree, follow these steps:

1. In the Welcome Window or from the File menu, choose New.

2. In the File Type list, select Ultimate Family Tree and choose Open.

3. In the File Name field, type a file name (up to eight characters) for the 
new project.

4. Select the drive and directory for the new project. Typically, it’s 
\UFT\PROJECTS. The current directory name appears above the direc-
tory list box.

Figure 1-4: New File Window

Figure 1-5: Save As Dialog Box

Type project

File list

Path to file
Save file

Directory list

Drive list

name
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Note Do not save to a floppy disk. Be sure you have sufficient disk
space on the hard drive before starting a new project. You need at le
2.5 MB of free disk space and 2.5 storage space for every 1,000 
individuals.

5. Choose OK. The Project has now been created and the Project Info
tion window is displayed.

Note To open the Project Information window at any time, choose 
Project Info from the File menu.

6. Enter a short description of the project, such as a family name, on th
Description line. The description appears on the title bar of the Ultim
Family Tree window.

7. Enter the name of the principal researcher for this project in the 
Researcher Field. This field is optional, but you can have the 
researcher’s name appear in the footer on printed reports by typing 
name here and choosing Preparer in the Page Setup window. See t
note below.

8. Enter the address of the researcher. This information can be include
the footer with the preparer’s name, if you want. You might include 
Prepared by: before the name to have the footer of your reports print
in this way.

Note To print the relationship of the preparer on Family Group repo
when Preparer Info is checked, enter the Researcher’s record numb
the Researcher # field. For a new project, enter an Individual Record
the preparer and then return here by choosing Project Info from the 
menu.

Figure 1-6: Project Information Window

The date the project 
was last edited

Update Key 

Path to the Project
Control file

Version number of 

Version number of
Ultimate Family Tree

project

Family list
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9. Key Families is a list of surnames in the project arranged in the orde
frequency of occurrence. Ultimate Family Tree keeps track of the nu
ber of times each surname is encountered and displays it to the righ
the name. This field is blank for a new project. Choose the Update b
ton to update the Key Families surname list. When new individuals h
been entered into Ultimate Family Tree, choose Update to get a new
count of the surnames.

10. The Comments box displays the source of the data used in this pro
including import method, date, and time. Enter general information 
about the project in this box.

11. Choose OK to close the window and save changes. The Individual 
Record window appears and you’re ready to begin.

To open an existing project, follow these steps:

1. From the Menu Bar, choose File.

2. Choose Open.

3. In the File Type drop-down list, select Ultimate Family Tree Project.

4. Select the drive and directory of the existing project. Select \UFT\SA
PLE directory if you want the Kennedy sample project, or the 
\UFT\PROJECTS directory if you’ve already converted or saved a 
project that you’d like to open.

5. Make sure that the proper drive, directory, and subdirectory appear 
above the directory list box.

Figure 1-7: Open Dialog Box

Path to file
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6. Select the project filename to be opened (for example, 
KENNEDY.PRO).

7. Choose Open. The Individual Record window appears and is ready
accept information about an individual.

See Section 8 of the Ultimate Family Tree User’s Guide for information 
on importing GEDCOM and ROOTS III files.

Getting Familiar with Ultimate 
Family Tree
You can use a mouse or keystrokes to execute commands in Ultimate Fa
Tree menus and windows. To use the mouse, position the pointer over a 
desired option and press the left mouse button. If a selection is required, 
ble-click the left mouse button. To use the keyboard, press the Tab or rev
Tab (Shift+Tab) keys to position the selection bar. If a selection is required
press Enter or the appropriate shortcut key.

Menu Bar
The Menu Bar contains a list of words extending across the main window
provides easy access to all aspects of the program.

To view a menu, click once on the menu name. A menu drops down unde
menu name. You can also use the keyboard to display menus. There are 
keyboard methods:

• Press the Alt key to activate the menu bar and then use the right or 
arrow keys to move across the bar to the menu name you want. Pres
down arrow key to open the menu.

• Press the Alt key followed by the underlined letter in the menu name

A similar approach is used to choose options within each menu. Use one
the following options:

• Press the left mouse button

Figure 1-8: Menu Bar

Title bar
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• Press Alt plus the underlined letter

• Press the combination of shortcut keys indicated next to an option

Note At certain times during operation of the program, some menu
selections are not available and a short menu appears. When the sh
menu bar is displayed, the Toolbar is not active.

The menu items access a wide range of functions. For a description
each menu item, see Online Help.

Function and Shortcut Keys
Several of the keyboard function keys help you enter data more efficiently
Others are used to move up and down lists, to find people or places, and 
access context-sensitive help. In combination with the Shift key or the Con
(Ctrl) key, the function keys perform a wide variety of additional tasks.

Shortcut keys are a combination of the Ctrl or the Alt key with a lette
key. Similar to the function keys, these specialized key strokes facilitate m
essential tasks, such as copy, paste, build, and help.

Here are helpful and frequently used keyboard shortcuts:

• F5 — To view an Individual Record, highlight a person’s name any-
where in the program and press F5.

• F8 — To open the Events window for an event, select the event and
press F8 or choose the numbered button to the left of the event nam

• F9 — To save data in a window, press F9, or in an Individual Record
click the Save button on the Toolbar.

• F10 — To find an individual, press F10. Type in that person’s record
number or first few letters of the name and choose Find to display th
full name. Choose OK.

See the back of the Ultimate Family Tree User’s Guide for a list of func-
tion and shortcut keys.

Toolbar
Below the Menu Bar is the Toolbar. It contains a set of buttons and icons 
you click to perform specific functions. These functions are also accessib
from the Menu Bar, but the Toolbar provides a shortcut if you use a mous
The Toolbar is not active when the short Menu Bar is displayed.

You can turn the Toolbar on and off, and you can disable the balloon
(command description) help associated with each Toolbar button. See pa
196 of the Ultimate Family Tree User’s Guide for instructions.
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The arrow buttons on the Toolbar serve two functions. They are use
move up and down lists opened from the View menu. They are also used 
change from one individual to another in windows where the Find button i
active. You can move to the previous, the next, the first or last person in th
project. The next person is determined by the order in which you last sele
and viewed an individual list. If the last individual list you opened resulted
from a search, the focus will change to those individuals in the search list

Reserved Characters
The following characters are reserved for use by Ultimate Family Tree an
must be considered when entering data:

• / — Used to mark surnames. On ROOTS III import, the pipe symbol
is substituted for extra forward slash characters in names. Do not us
forward slash character in names except to mark the beginning and
of the surname.

• # — The number sign is used in role sentence codes. Do not use th
number sign in name, event detail, place, or date fields.

• { } — Used to mark a title in a person’s name. Can be used in other 
fields, subject to the restrictions under Rich Text Format listed in the
next section, “Rich Text Format Printing.”

Rich Text Format Printing
Rich Text Format (RTF) is a data exchange format developed by Microso
allow formatted text to be moved from one application to another. Fonts, 
underlining, index information, footnotes, and most other format instructio
are preserved.

• \  — Used for control codes in RTF files. Do not use the backslash c
acter in Ultimate Family Tree if you will be using the RTF feature.

Figure 1-9: Toolbar
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• { } — Used for control codes in RTF files. Do not use the left or right
brace character (except to mark a title in a name) if you will be using
RTF feature.

International Characters
If your keyboard does not have the accented keys you want for special ch
ters, position the cursor in the location where you want the character to ap
Hold down the Alt key and use the numeric keypad to type the three-digit 
ASCII number for the character, or copy and paste the character from the
dows Character Map. Ultimate Family Tree uses the MS Sans Serif font in
name fields. Use the Arial font setting in the Windows Character Map. Se
your Windows manual for help with Character Map.

Quick Start Tutorial
The Quick Start Tutorial is designed to help you learn how to perform the 
lowing tasks:

✓ Add a new individual

✓ Add parents

✓ Create a birth event

✓ Create a marriage event and add a spouse

✓ Create other events such as a graduation

✓ Create a divorce or an engagement event

✓ Move around the Individual Record window

✓ Add evidence and text

✓ Add a child

✓ Add a sibling

✓ View a family in a Family Tree (Pedigree) window

✓ View an individual

For additional hints and tips, see “Did You Know?” on page 27.
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Creating an Individual Record
All information about an individual is entered in the Individual Record win-
dow. This is a simple, fill-in-the-blanks screen where an individual’s name
sex, parents, spouse, children, siblings, and life’s events are entered, as w
any text and footnotes for that person.

Other windows are for medical information, miscellaneous informati
such as nationality, languages, aliases, and social security numbers. A m
window is used to attach images or audio recordings to the record for the
vidual.

In the following exercise, you’ll add a new individual and parents, an
create birth and marriage events.

Creating a New Record for Yourself
1. If this is a new project, the Individual Record window displays record

number 1. If not, choose the New Individual button to display a new Indi-
vidual Record window with the next available record number.

2. In the Name field, type your full name given at birth. Ultimate Family
Tree automatically marks the surname with slash (/) characters.

3. See Section 2, page 29 of the Ultimate Family Tree User’s Guide for 
more information on entering names which include titles.

4. Tab to the Sex field. Type M, F, or U. Alternatively, you can press the
down arrow and select Male, Female, or Unknown from the drop-do
list.

Figure 1-10: Individual Record Window
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5. Tab to the Living field. Type Y(es), N(o) or U(nknown). Alternatively, 
you can use the mouse to select one of these options from the drop
down list.

Note Use the mouse or the Tab key to move forward from field to fie
in the Individual Record window. Shift+Tab moves you in the opposi
direction.

Adding Parents
1. Tab to the Father field and type the name of your father.

2. Tab to the Mother field and type the name of your mother.

If you enter a full name in either the Parents or the Spouse fields for
individual that has already been entered into Ultimate Family Tree, a mes
appears when the window is being saved stating that this name has alrea
been entered. If it is a different person, choose New. If the person has alr
been entered, highlight the person’s name and choose List to link that ind
ual. If you want to make changes, choose Cancel to return to the Individu
Record window.

To edit the parents records, choose the associated button to the righ
the parent name. Choose Fa to edit the father’s record. Choose Ma to edit the 
mother’s record.

Creating a Birth Event
1. Tab to the Birth event date field.

2. Type your birth date using any format you want. See Section 8, pag
195 of the Ultimate Family Tree User’s Guide for information on setting 
date preferences.

3. Tab to the Place field and type the place of birth.

Note You can select an event name and press F8 or click the numb
button to the left of the event name to open the Events window wher
you can enter more detailed information. See page 30 of the Ultimate 
Family Tree User’s Guide for more information on the Events window.

Creating a Marriage Event and Adding a Spouse
1. If your spouse is not yet in the project, choose the New Spouse butto

create a new Individual Record along with a marriage record. If a ma
riage event has not yet been created for your parents, you are given
option to add one now.
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2. A new Individual Record opens. Type the name of your spouse in th
Name field.

3. Press Tab to move to the date field of the newly created marriage ev
and type the date on which the marriage took place.

4. Tab to the Place field and type the location of the marriage.

5. Click the “S” button to the right of the spouse’s name field to return t
your Individual Record.

Creating Other Events
1. Choose the New Event button to add another event. The Events win

opens.

2. Select any event from the list. To scroll the list, use the down arrow 
the scroll bar or type the first letter of the event you want to move to

3. With the event highlighted, type the free-form date in the Date field. T
structured and sort date fields are automatically calculated and ente
when you Tab out of the Free-form date field.

4. Tab to the Place field and type the place name where the event occ

5. When certain events are created, an event detail line becomes avai
For example, in the case of graduation, the detail is the institution or
school from which you graduated. Type the detail information in the 
event detail line and press Enter. A marriage or divorce type event a
vates the Spouse field where you can enter the name of the other in
vidual linked to this event.

Figure 1-11: Events Window
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These events use the Event Detail field:

6. Choose OK to return to the Individual Record window.

Adding Evidence, Text, and Other Information
1. Practice using the Tab key to move around the Individual Record wi

dow. Notice the context-sensitive help that appears at the bottom of y
Ultimate Family Tree window as you move from field to field.

Note Use the buttons to the right of the Events list to move up or do
the list. An individual can have a virtually unlimited number of events
recorded for his or her life. Next to the Place field in the Events list a
two columns of status boxes for Event Text and Event Evidence. An
in the status box indicates Text, Evidence, or both are present.

2. Select the Birth event you created for yourself and click the Text Sta
box to open a window where you can type free-form notes about thi
event. Up to 65,000 characters of text can be entered here. Type a f
words and choose OK to save the data and close the text window. A
shows that text is present for this event.

3. Choose the Event Evidence Status box to open a window where you
enter evidence to support the event, such as a birth certificate. See 
40 of the Ultimate Family Tree User’s Guide for information about 
entering sources.

4. Choose the Text and Evidence buttons to type notes about an indivi
(up to 65,000 characters) and attach evidence documenting your kn
edge of that individual. The Individual Text and Individual Evidence 
buttons work the same way as the Event Text and Event Evidence S
boxes.

Event Detail

burial cemetery

graduation and education events institution or school

resides street address

resided street address

employment occupation

emigration point of origin

immigration destination

baptism religion

LDS events temple code
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5. Choose the More button to open an Individual More window and the
choose Miscellaneous to open the Miscellaneous Individual Informat
window. Record miscellaneous information about yourself. Type you
Social Security number in the last field and choose OK to close the win

6. Choose the More button, and then Medical to open the Medical Hist
window in which you can enter physical details and medical conditio
Choose a medical condition to open a second window where you ca
type up to 65,000 characters of information about that condition. 
Choose OK and return to the original Medical History window. Type 
your weight, height, and hair and eye color in the Physical character
tics group. Choose OK.

7. Choose the More button, and then Media to open the Multimedia Lin
window where you can attach and display or play image or audio 
recording files linked to an individual. See Section 7 of the Ultimate 
Family Tree User’s Guide for information about adding and linking 
Media.

8. Choose Cancel to close the Multimedia Link window and return to th
Individual Record window.

Adding a Child
The Children box lists all children of the selected individual.

1. Add a child by choosing the New Child button at the bottom of your 
Individual Record window.

2. In the Parent window, specify the name of the other parent and cho
Selected. A new Individual Record window opens with the child’s su
name already entered and the parent’s names in the Mother and Fa
fields.

Figure 1-12: Individual More Window

Open Miscellaneous Individual
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Open Multimedia Link window



QUICK  START TUTORIAL 2 3

ect 

and 

.

t-
s 

t 

rd.

 sib-
s. 

t 
 

Note If the correct parent is not listed in the Other Parent window, 
choose None. A new Individual Record window opens. Enter the corr
parent (if known) in the Father or Mother field.

3. Type your child’s given name before the surname in the name field 
complete the rest of the information.

Adding a Sibling
The Siblings window lists all siblings of the subject, including half-siblings

1. From a child’s Individual Record window choose the New Sibling bu
ton to add a brother or sister. A new Individual Record window open
for your child’s brother or sister with the sibling’s surname already 
entered, along with your name and your spouse’s name in the paren
fields.

2. Complete the sibling’s name field and the rest of the Individual Reco

Note To use the Sibling button on the Individual Record, you must 
have entered a parent. If you do not know the parents for a group of
lings, enter a name for the father or mother in one of the parent field
For example, for an individual named John Smith, you could enter a 
father or mother named Unknown /Smith/, or (-----) /Smith/.

You have just entered three generations of individuals in your projec
and familiarized yourself with the Individual Record window. Now you can
view your data.

Figure 1-13: Other Parent Window

Choose to specify a
parent in the list
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Viewing Ancestors in the Family Tree (Pedigree) Window
1. From the View menu, choose Family Tree to leave the Individual Rec

window and open the Family Tree window, which is also known as a
Pedigree chart.

2. Click the Find Individual button on the Toolbar or press the Find Key
(F10) to open the Find individual window. Type the number 1 and pr
Enter (or choose Find) to find your name. Choose OK.

The Family Tree window opens with your name in the focus pos
tion with generation 1 displayed beneath it. You can view up to five g
erations of a family at once. Your children are listed at the top left and
you have entered any of your siblings, they are listed at the bottom l
A plus (+) sign to the left of a name in the Child or Sibling window 
means that this person has descendants.

The generation number changes depending on the generation o
focus person in relation to the original starting person displayed at th
upper left of the Family Tree window.

3. Double-click your name in the upper-left corner of the window to brin
yourself back to the focus position. Choose Close to close the windo

Viewing a Family Group
1. From the View menu, choose Family Group. The husband and his p

ents (if known) are displayed at the top, the wife and her parents are
played in the center, and their children appear at the bottom of the 
window.

Figure 1-14: Family Tree (Pedigree) Window
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2. To change the focus of the window, click Parents to move your pare
into the Husband and Wife fields. Select a child in the Child list box a
choose the Child button to change the focus to that child.

3. Select your name and choose Close to close the window.

Viewing an Individual Summary
1. From the View menu, choose Individual Summary to view all the info

mation recorded about yourself. This window can be sized smaller o
larger for ease of reading.

Figure 1-15: Family Group Window
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Figure 1-16: Individual Summary Window
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Note Event details are displayed twice when viewing an Individual 
Summary. Because the Individual Summary shows a summary of all
information entered for an event, it displays the text that will be print
in the report as well as the basic data entered in the detail field. For
reason, you can view the more extensive event information that can
entered into ROOTS IV and then accessed in Ultimate Family Tree. 
What you see as a duplicate detail on the computer screen will not p
in your report.

2. Scroll through the text to review the information that you entered.

3. Close the window by choosing the Close box or by pressing Escape

If you have entered data for your family during this tutorial session, y
can now add to it. If you would like to delete this tutorial project and start 
anew, follow the steps in the next section.

Deleting a Project
1. Choose Delete Project from the File menu. A warning window open

with this message, ARE YOU SURE? ### records will be PERMA-
NENTLY deleted if you choose OK.

2. Choose OK.

3. Another window appears with this message: ARE YOU SURE? This 
project will be PERMANENTLY erased if you choose OK. Choose OK.

Figure 1-17: Delete Project Warning
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Did You Know?
There are some important features and short cuts built into Ultimate Fam
Tree designed to make entering your data easy. Read through this section
description of some of these features. See “Frequently Asked Questions”
page 206 of the Ultimate Family Tree User’s Guide for answers to common 
questions.

Go Menu
The Go menu has two functions. It gives you the ability to move through l
and to quickly return to recently edited records. Choose Go Top to move to
first person in the project. Choose Go Bottom to move to the last person. 
Choose Up or Down to move to the next person in the list. The person’s p
tion in the list is determined by the order in which you last selected and 
viewed an individual list. If the last list you opened resulted from a search,
focus will change to those individuals in the search list.

Up to ten individual names are displayed in the Go List. Each time y
open an Individual Record, the name of that individual is moved to the top
the list. From the Go menu, choose any name in the list to return to that in
vidual’s record.

The New Spouse Button
To enter a new spouse for an individual, choose the New Spouse button. 
Individual Record window opens allowing you to enter the name and othe
information for the new spouse. You can return to the first spouse by choo
the “S” button to the right of the name on the Spouse field or by selecting
name from the Go menu. The marriage information can be entered in eith
record.

If the spouse is already in the project, choose New Event rather than
New Spouse. Select Marriage from the list and type part of the name in th
Spouse field. Choose Find to open the Candidate Individuals list with indi
uals whose names begin with the letters you typed in the list. Select the n
and choose OK. If you type the complete name instead of choosing Find,
message appears when you save the record asking if the person is an ex
person from the list. If so, choose List. If it is a new person, choose New.

Text and Evidence Status Boxes
Event text and evidence can be added in the Events window or in the Ind
ual Record window. Two columns to the right of the Event Place field in th
Individual Record window contain Text and Evidence status boxes. Click 
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Text or Evidence status box to open the associated window. An X in the status 
box indicates that data is present.

Choose the numbered button next to an event name to open the Ev
window where you can choose the Text or Evidence button to enter additi
information.

Using Undo
If you choose the New Individual, New Spouse, New Child or New Sibling
button and decide not to create the new record, choose Undo from the Ed
menu to delete the record and return to the previous record.

Note Undo is not available if the record has been saved. As you en
information, the record is saved automatically. To delete a saved rec
from the File menu, choose Delete Record.

Date Preferences
You can specify the date format for the free-form date field. Set your prefe
ence to have dates display and print exactly as you’ve entered them or se
date format default such as 12 JUL 1943.

From the Utilities menu, choose Desktop Preferences, and then Mis
laneous. Scroll through the date options and select the format you want. If
select any option other than “As entered,” modifiers will be converted to fu
words in the free-form date field, such as ABT to about. Dates entered be
selecting a date preference are unchanged.

Graphics Display
Ultimate Family Tree provides two styles for desktop display, Graphics an
Windows Colors. The graphics mode can reduce the performance of the p
gram. If you suspect that Ultimate Family Tree is running more slowly tha
should, switch to the Windows color mode.

From the Utilities menu, choose Desktop Preferences and then Misc
laneous. Choose Use Window colors and “none” in the Wallpaper drop-do
list to change to Windows colors. Restart Ultimate Family Tree to complet
the change.

When you open certain window while in the graphics mode, the mes
sage, “Picture colors may be incorrect. Do you wish to use Windows Colo
may appear. Choose No to ignore the message and open the window. Ch
Yes to change the desktop display to Windows Colors. Exit and then resta
Ultimate Family Tree to change to Windows colors. This message will app
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if your graphics monitor is set to 256 colors. If your monitor is set to 16 co
ors, the Windows Colors are used.

Editing Place Names
If you want to edit or combine place names, create a new Individual Reco
for a temporary person. Select “an unknown location” on the birth event fi
and choose the Find button. A list of all places in the Place Library is 
displayed. Scroll throughout the list to find place records you want to edit.
Highlight a place name and choose OK. Edit the place name and press F
choose the Save button on the Toolbar or Save from the File menu. A mes
appears stating that the place name has been changed. Choose OK to sa
spelling change. Because the Place Library is common to all projects, cha
ing the spelling will change it globally throughout the open project and all 
other projects.

To edit another place, highlight the place name in the Individual Rec
and press the Del (Delete) key on your keyboard. Press F9 to save and th
choose the Find button to reopen the Place List. Select another place from
list.

Note See pages 192 of the Ultimate Family Tree User’s Guide for 
information on combining duplicate place names.

When you have completed editing the place names, from the File me
choose Delete Record to delete this temporary record from the project.

Finding Individuals
There are several ways to find new subjects for the Individual Record wind
besides using the Find Individual window. If you select the main name field
the Individual Record window and choose the Find button, a list of all indiv
ual in the project opens. The list is alphabetical by given name. Press any 
on the keyboard to move to the given names in the list which start with tha
letter. Select a name and choose OK to change to that person’s record.

You can also choose a name from the Individual List. From the View
menu, choose Individual List, and then by Surname. Scroll through the list
double-click the left mouse button on a name to open the Individual Reco
for that person.

From the Go menu, choose any name to move to that person Individ
Record. Up to ten of the last individuals edited are displayed in the Go lis

See page 80 of the Ultimate Family Tree User’s Guide for information 
on using the Find Individual window.
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Using Existing Records for Parent and Spouse Fields
If you enter a full name in either the Parents or the Spouse fields for an in
vidual that has already been entered into Ultimate Family Tree, a messag
appears when the window is being saved stating that this name has alrea
been entered. If it is a different person, choose New. If the person has alr
been entered, highlight the person’s name and choose List to link that ind
ual. If you want to make changes, choose Cancel to return to the Individu
Record window.
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Welcome to Ultimate Family Tree™ and the exciting world of genealogy. 
Genealogy is the pursuit of knowledge about our past. It’s a way to look at
families in order to better understand ourselves. With Ultimate Family Tre
you can view the past in ways never dreamed possible by your ancestors

Ultimate Family Tree’s easy-to-use data entry screens, Instant Web P
Publisher, spell checker, and online capabilities are firsts for any genealo
software. Using Ultimate Family Tree, you can document events in each i
vidual’s life by drawing from a library of almost 200 predefined events or b
creating your own. Fundamental information for each person is entered 
through Ultimate Family Tree’s powerful Individual Record window.

The online functions provided by Ultimate Family Tree are its most 
exciting feature. It’s possible to connect directly to the program’s exclusive
Web site and converse with research experts, download useful genealogi
information, and upload your own family history Web page.

Soon you will be entering your own information and creating beautif
journals of loved family members. To help you get started with your genea
ical research Palladium Interactive has furnished an on-disk Beginner’s Guide 
to Genealogy in Adobe Acrobat Reader format. The Beginner’s Guide to 
Genealogy is called BEGINNER.PDF and is found in the DOCS folder of th
Ultimate Family Tree CD-ROM. Also in this directory you will find complet
user’s guides in PDF format.
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Help is Always at Your Fingertips
Ultimate Family Tree provides the following help:

• The Ultimate Family Tree User’s Guide on CD-ROM

• The Ultimate Family Tree Web Site http://www.uftree.com

• Online Help—an online reference guide that includes context sensit
help, extensive cross referencing, troubleshooting assistance, a guid
error messages, answers to frequently asked questions, and a gloss

• Technical support

If you have questions about any aspects of the program, follow these step

1. Check the Table of Contents and the Index of the Ultimate Family Tree 
User’s Guide for the subject with which you need help, or from the He
menu, choose Help or Help Topics.

2. See “Troubleshooting” in Section 9 of the Ultimate Family Tree User’s 
Guide and online help for answers to common problems.

3. Contact Ultimate Family Tree Technical Support:

• FAX 812-829-1020

• Mail 743 E. Franklin Street, Suite B, Spencer, IN 4746

• CompuServe GO GENSUP

• Internet (email) pifamily@palladiumnet.com

• Telephone 812-829-4405 (8 AM–10 PM CST, M–F)

If you call for technical support, please call while you’re at your com
puter. Technical support is offered for questions or problems using Ultima
Family Tree. For questions on using your computer, consult the Macintosh 
User’s Guide or contact Apple at (800) SOS-APPL.

Getting Ready to Install

System Requirements
Ultimate Family Tree is a Macintosh program designed for System 7.0.1 o
higher, 68040 or PowerMac, 8 MB RAM (16 MB strongly recommended f
better performance), 22 MB free hard disk space (plus 5 MB per thousan
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names, and an additional 11 MB if installing AT&T WorldNetSM), a color 
monitor, and a double-speed CD-ROM drive. A modem (9600 bps minimu
14.4 kbps or greater recommended) and Internet access are required to u
Go Online feature.

A word processor is also required. Ultimate Family Tree prepares ch
and reports to be displayed and printed with any word processor capable
importing Rich Text Format (RTF) files. Microsoft Word is recommended. 
Box charts are sent directly to your printer.

Note If you have less than 16 MB of physical RAM you must turn o
Virtual Memory to run Ultimate Family Tree. Using Virtual Memory 
will significantly slow the performance of your Macintosh.

If AppleScript™ and AppleScriptLib™ are not found, they will be
installed (these system extensions are required to run Ultimate Fam
Tree, and must be enabled by rebooting).

Make Sure You Have Everything You Need
Your Ultimate Family Tree package should include:

• This guide

• Registration card

• On-Line Guide

• Upgrade instructions

• Ultimate Family Tree CD-ROM

Customer Registration
Fill out and mail the enclosed registration card immediately. This card qua
fies you to receive free technical support and notification of upgrades.

Installing Ultimate Family Tree

Installation Instructions
To install Ultimate Family Tree as a new program, follow these steps:

1. Insert the Ultimate Family Tree CD-ROM.

2. Double-click the Ultimate Family Tree Install icon.
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3. A warning will appear if you have less than 16 MB of RAM, and you
will be prompted to continue or quit (if you have more than 16 MB o
RAM you will not see this warning). It is possible to complete the 
installation with less than 16 MB of RAM, but the product will suffer 
performance problems.

4. The Ultimate Family Tree start-up logo appears. Click Continue.

5. The README box appears. The README file contains late-breakin
information regarding the product that could not be included in the m
ual. You have the option to read, print, or save the README file to di
Make your choice and then click Continue.

6. At the SETUP window, click Install if you have never installed the pr
gram before. This will install all of the Ultimate Family Tree Deluxe 
software.

7. When all products have been installed, you will be prompted to rest
your Macintosh.

On-Line Guide and Browser Setup
After you have installed Ultimate Family Tree you must run the Browser 
Setup program to enable the on-line functionality of the program. Refer to
instructions in the enclosed On-Line Guide to configure your browser for 
with the Palladium Interactive Members Only Web Site. Double-click the 
Browser Setup Icon and follow the on-screen instructions.

Reinstalling Ultimate Family Tree
1. Insert the Ultimate Family Tree CD-ROM.

2. Double-click the Ultimate Family Tree Install icon.

3. A warning will appear if you have less than 16 MB of RAM, and you
will be prompted to continue or quit (if you have more than 16 MB o
RAM you will not see this warning). It is possible to complete the 
installation with less than 16 MB of RAM, but the product will suffer 
performance problems.

4. The Ultimate Family Tree start-up logo appears. Click Continue.

5. The README box appears. The README file contains late-breakin
information regarding the product that could not be included in the m
ual. You have the option to read, print, or save the README file to di
Make your choice and then click Continue.
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6. On the upper left corner of the SETUP window, locate the box label
Easy Install. Click the down arrow and choose Custom Install. To 
remove Ultimate Family Tree from your hard disk, choose Remove.

7. Select the product or files you want to install: Application Files, 
Browser Setup, Extensions, Image Files, Records Requester, Famil
Album Maker, Social Security Death Index, Gazeteer.

8. Select Application Files to reinstall the application files only.

Warning If you select Library Files, any existing library files will be
overwritten and result in data loss.

9. Follow steps 4–7 in “Installing Ultimate Family Tree” to complete the
reinstallation.

Starting Ultimate Family Tree
Before starting Ultimate Family Tree you should be familiar with your Mac
tosh and have Ultimate Family Tree installed on your computer. 

To start Ultimate Family Tree, follow these steps:

1. Open the Ultimate Family Tree folder.

2. Double-click the Ultimate Family Tree icon. If you are starting Ultima
Family Tree for the first time, the Ultimate Family Tree splash screen
appears, followed by the Welcome window with a message stating t
Ultimate Family Tree did not find an open project.

3. You are offered the following options:

Figure 2-1: Ultimate Family Tree Folder

Double-click to start
Ultimate Family Tree
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• New — Begin a new project from scratch

• Open — Open an existing Ultimate Family Tree project

• Quit — Leave Ultimate Family Tree

Ultimate Family Tree Desktop Display
Ultimate Family Tree provides two styles for desktop display: custom grap
ics and Macintosh colors. Using Macintosh colors establishes desktop an
window colors from the Color control panel. (If your monitor is set to 16 co
ors, Macintosh Colors are used by default.)

Using the custom graphics display can reduce the performance of th
program. If you suspect that Ultimate Family Tree is running more slowly 

Figure 2-2: Welcome Window

Figure 2-3: Individual Record with Custom Graphics 
Desktop Display

Open Miscellaneous,
Medical, and Media
windows

Go to top of event list
Move up one event
Move down one event
Go to bottom of event list
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than it should, refer to page 163 for instructions on how to switch to the M
intosh colors mode. Choose the option for Ultimate Family Tree according
your personal preference and system performance.

Note The illustrations in this Guide were made using the Macintosh 
Colors option.

Creating a New Project
To start a new project in Ultimate Family Tree, follow these steps:

1. In the Welcome window or from the File menu, choose New. A New 
File window opens.

2. In the Type list, select Ultimate Family Tree and click OK.

3. In the Specify a New Project Name field, enter a name for the new 
project.

Figure 2-4: Ultimate Family Tree with Macintosh Colors 
Desktop Display

Click to edit event text

Click to edit event 
evidence

Figure 2-5: New File Window
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4. Select the folder for the new project. Typically, it’s called Projects. T
current folder name appears above the file list.

Note Do not save to a floppy disk. Be sure you have sufficient disk
space on the hard drive before starting a new project. You need at le
2.5 MB of free disk space for every 1,000 individuals.

5. Click Save. The project has now been created and the Project Inform
tion window is displayed.

Note To open the Project Information window at any time, choose 
Project Info from the File menu.

6. Enter a short description of the project, such as a family name, on t
Description line.

7. Enter the name of the principal researcher for this project in the 
Researcher field. This field is optional, but you can have the research

Figure 2-6: New Project Name Window

Type project name

File list

Path to file

Save file

Figure 2-7: Project Information Window

The date the
project was 

Update Key 

Path to the
Project Control Version number

Version number
of Ultimate

Family list

last edited

file

Family Tree

of project
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name appear in the footer on printed reports by typing a name here
checking the Preparer box in the Page Setup window. See the note 
below.

8. Enter the address of the researcher. This information can be include
the footer with the preparer’s name, if you want. You might include 
Prepared by: before the name to have the footer of your reports print
in this way.

Note To print the relationship of the preparer to the husband and w
on Family Group reports when Preparer Info is checked, enter the 
Researcher’s record number in the Researcher # field. For a new pro
enter an Individual Record for the preparer and then return here by 
choosing Project Info from the File menu.

9. Key Families is a list of surnames in the project arranged in the orde
frequency of occurrence. Ultimate Family Tree keeps track of the nu
ber of times each surname is encountered and displays it to the righ
the name. This field is blank for a new project. Click the Update butt
to update the Key Families surname list. When new individuals have
been entered into Ultimate Family Tree, choose Update to get a new
count of the surnames.

10. The Comments field displays the source of the data used in this pro
including import method, date, and time. Enter general information 
about the project in this box.

11. Click OK to close the window and save changes. The Individual Rec
window appears and you’re ready to begin.

Opening an Existing Project
To open an existing project, follow these steps:

1. Choose Open from the File menu.

Figure 2-8: Open File Window
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2. In the File Type list, select Ultimate Family Tree and click Open.

3. Select the folder for the existing project. Select the Sample folder if y
want to open the Kennedy sample project, or the Projects folder if 
you’ve already converted or saved a project that you’d like to open.

4. Select the project you want to open.

5. Click Open. The Individual Record window appears and is ready to 
accept information about an individual.

Getting Familiar with Ultimate 
Family Tree
You can use your mouse or keyboard to execute most commands in Ultim
Family Tree menus and windows. To use the mouse, position the pointer 
a desired option and press the mouse button. If a selection is required, do
click the mouse button. To use the keyboard, press the appropriate shortc
key.

Menu Bar
The menu bar contains a list of words extending across the main window.
provides easy access to all aspects of the program.

To view a menu, point on the menu name, hold down the mouse but
move the pointer to highlight your choice, and release the mouse button. 

Figure 2-9: Open File Window

Path to file
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certain times during operation of the program, some menu selections are
available and appear grayed out. At other times, a different set of menu it
will appear, depending on your activity in Ultimate Family Tree.

The menu items access a wide range of functions. For a description
each menu item, use Online Help by choosing Help from the Help menu.

Shortcut Keys
Several of the keyboard keys help you enter data more efficiently, find peo
and access context-sensitive help.

Shortcut keys are a combination of the  (Command) key with a lett
key. These specialized keystrokes facilitate many essential tasks, such as
paste, and help.

Here are some helpful and frequently used shortcuts:

• -A — Select All

• -B — Spell Check

• -C — Copy

• -D — Delete Record

• -F — Find Text

• -G — Find Text Again

• -I — Project Information

• -L — Locate (Find) Individual

• -P — Print

• -Q — Quit

• -R — Redo

• -S — Save

• -V — Paste

• -X — Cut

Figure 2-10: Menu Bar

Online help
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• -Z — Undo

• -/ — Help

See the back of the Ultimate Family Tree User’s Guide for a handy list 
of shortcut keys.

Reserved Characters
The following characters are reserved for special use by Ultimate Family T
and must be considered when entering data:

• / — The forward slash is used to mark surnames. Do not use the forw
slash character in names except to mark the beginning and end of t
surname.

• # — The number sign is used in role sentence codes. Do not use th
number sign in name, event detail, place, or date fields.

• { } — Braces are used to mark a title in a person’s name. Can be use
other fields, subject to the restrictions under Rich Text Format listed
the next section, “Rich Text Format Printing.”

Rich Text Format Printing
Rich Text Format (RTF) is a data exchange format developed by Microso
allow formatted text to be moved from one application to another. Fonts, 
underlining, index information, footnotes, and most other format instructio
are preserved. For more information on RTF and printing in Ultimate Family
Tree, see Section 5 of the Ultimate Family Tree User’s Guide. Please be aware 
of the following special characters:

• \ — The backslash is used for control codes in RTF files. Do not use
backslash character in Ultimate Family Tree.

• { } — The braces are used for control codes in RTF files. Do not use 
left or right brace character except to mark a title in a name.

Ultimate Family Tree and WindowShade
The Apple system extension WindowShade is incompatible with Ultimate 
Family Tree. WindowShade allows you to roll up an open window into its ti
bar by double-clicking the window’s title bar. Using WindowShade in Ulti-
mate Family Tree may cause screen redraw problems. However, it will not 
corrupt your data or cause Ultimate Family Tree to crash.
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Quick Start Tutorial
The Quick Start Tutorial is designed to help you learn how to perform the 
lowing tasks:

✓ Add a new individual

✓ Add parents

✓ Create a birth event

✓ Create a marriage event and add a spouse

✓ Create other events such as a graduation

✓ Create a divorce or an engagement event

✓ Move around the Individual Record window

✓ Add evidence and text

✓ Add a child

✓ Add a sibling

✓ View a family in a Family Tree (Pedigree) window

✓ View an individual

For additional hints and tips, see “Did You Know?” on page 52.

Creating an Individual Record
All information about an individual is entered in the Individual Record win-
dow. This is a simple, fill-in-the-blanks screen where an individual’s name
sex, parents, spouse, children, siblings, and life events are entered, as w
any text and footnotes for that person.

Other windows are for medical information and miscellaneous inform
tion such as nationality, languages, aliases, and social security number. A
media window is used to attach images to the individual record.

In the following exercise, you’ll add a new individual and parents, as
well as create birth and marriage events.

Creating a New Record for Yourself
1. If this is a new project, the Individual Record window displays record

number 1. If not, click the Individual button at the bottom of the window 
to create a new record with the next available record number.
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2. In the Name field, type your full name given at birth. Ultimate Family
Tree automatically marks the surname with slash (/) characters whe
you move the cursor to the next field or click a button.

Note See Section 2, page 27 of the Ultimate Family Tree User’s Guide 
for more information on entering names which include titles.

3. Set the sex of the individual by selecting Female, Male, or Unknown
from the pop-up menu.

4. Choose No, Yes, or Unknown from the Living pop-up menu.

Note Press Tab and Shift-Tab or use the mouse to move from field
field in the Individual Record window.

Adding Parents
1. Put the cursor in the Father field and type the name of your father. 

2. Press Tab to move to the Mother field and type the name of your mo
If either parent is already in the project, type the first name of the pa
in the appropriate field and click the Find button next to the Spouse 
field. A list of everyone with that name will appear in the Candidate 
Individual window. Select the correct individual and click OK. 

If you enter a full name in the Father, Mother, or Spouse field for an 
individual that has already been entered into Ultimate Family Tree, a mes
appears when the window is being saved stating that the name has alrea
been entered. If it is a different person, click New. If the person has alread
been entered, highlight the person’s name and click List to link that individu
If you want to make changes, click Cancel to return to the Individual Reco

Figure 2-11: Individual Record Window

Click to edit 

Create a new
individual

Open father’s
individual record

Open mother’s
individual record

Open spouse’s
individual record

Open event
window (add new 

event

event)



QUICK  START TUTORIAL 4 5

t of 

s 
rded. 
, No 
Indi-

e 

 to 
 

e 
 
ur 

e 

t 

r-

e 
er 
window. To edit the parents’ records, click the associated button to the righ
the parent’s name—click Fa to edit the father’s record or Mo to edit the 
mother’s record.

If a marriage record is not found for the parents, a message appear
when saving, “The marriage event for the parents of … has not been reco
Do you wish to add a marriage event now?” Click Yes to create a marriage
to save the record without creating a marriage, or Cancel to return to the 
vidual Record window without saving.

Creating a Birth Event
1. Move the cursor to the Birth event date field.

2. Type your birth date using any format you want. See Section 8, pag
164 of the Ultimate Family Tree User’s Guide for information on setting 
date preferences.

3. Press Tab to move to the Place field and type the place of birth.

Note You can select an event name and click the numbered button
the left of the event name to open the Events window where you can
enter more detailed information. See page 28 of the Ultimate Family 
Tree User’s Guide for more information on the Events window.

Creating a Marriage Event and Adding a Spouse
1. If your spouse is not yet in the project, click the Spouse button at th

bottom of the window to create a new Individual Record along with a
marriage record. If a marriage event has not yet been created for yo
parents, you are given the option to add one now.

2. A new Individual Record opens. Type the name of your spouse in th
Name field.

3. Move the cursor to the date field of the newly created marriage even
and type the date on which the marriage took place.

4. Press Tab to move to the Place field and type the location of the ma
riage.

5. Click the S button to the right of the spouse’s name field to return to 
your Individual Record. (For additional information, see “Creating a 
New Marriage Event” on page 33 of the Ultimate Family Tree User’s 
Guide.)

Note Use the transport buttons to the right of the Events list to mov
up or down the list. An individual can have a virtually unlimited numb
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of events recorded for his or her life. Next to the Place field in the 
Events list are two columns of status boxes for Event Text and Even
Evidence. An X in the status box indicates text, evidence, or both are
present.

Creating Other Events
1. Click the Event button at the bottom of the window to add a new eve

The Events window opens.

2. Select any event from the list. To view the entire list of events, use t
scroll bar or type the first letter of the event you want.

3. With the event highlighted, type the free-form date in the Date field. T
structured and sort date fields are automatically calculated and ente
when you select another field in the Events window.

4. Move the cursor to the Place field and type the place name where th
event occurred.

5. When certain events are created, an event detail line becomes avai
For example, in the case of graduation, the detail is the institution or
school from which your subject graduated. Type the detail informatio
in the event detail line and press Return. The marriage and divorce 
events activate the Spouse field where you can enter the name of th
other individual linked to this event.

6. Click OK to return to the Individual Record window.

Figure 2-12: Events Window

Delete event 

Create custom
event

Event 

Role definition

Add text about
this event

Add evidence
about this event

Find a place
or person

definition

type
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These events use the Event Detail field:

Adding Evidence, Text, and Other Information
1. Select the Birth event you created for yourself and click the Text sta

box to open a window where you can type free-form notes about thi
event. Up to 65,000 characters of text can be entered here. Type a f
words and click OK to save the data and close the text window. An X 
shows that text is present for this event.

2. Click the Event Evidence status box to open a window where you ca
enter evidence to support the event, such as a birth certificate. (See
39 of the Ultimate Family Tree User’s Guide for information about 
entering sources.)

3. Click the Text and Evidence buttons on the Individual Record windo
to type notes about an individual (up to 65,000 characters) and attac
evidence about that individual. The Individual Text and Individual Ev
dence buttons work the same way as the Event Text and Event Evid
status boxes.

4. Click the More button to open an Individual More window and then 
click Miscellaneous to open the Miscellaneous Individual Information
window. Record miscellaneous information about yourself. Type you
Social Security number in the last field and click OK to close the wind

5. Click the More button, and then click Medical to open the Medical H
tory window in which you can enter physical details and medical con
tions. Click a medical condition to open a second window where you

Event Detail

burial cemetery

graduation and education events institution or school

resides street address

resided street address

employment occupation

emigration point of origin

immigration destination

baptism religion

LDS events temple code
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can type up to 65,000 characters of information about that condition
Click OK and return to the original Medical History window. Type you
weight, height, and hair and eye color in the Physical characteristics
group. Click OK.

6. Click the More button, and then click Media to open the Media Link 
window where you can attach and display image files linked to an in
vidual. (See Section 7 of the Ultimate Family Tree User’s Guide for 
additional information about adding and linking media.)

7. Click Cancel to close the Media Link window and return to the Indiv
ual Record window.

Adding a Child
The Children field lists all children of the selected individual.

1. Add a child by clicking the Child button at the bottom of your Individ
ual Record window.

2. In the parent selection window, choose the name of the other paren
click Selected. A new Individual Record window opens with the child
surname already entered and the parent’s names in the Mother and
Father fields.

Figure 2-13: Individual More Window

Open Miscellaneous Individual
Information window

Open Medical History window

Open Media Link window

Figure 2-14: Parent Selection Window

Choose to specify a
parent in the list
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Note If the correct parent is not listed in the parent selection windo
click None. A new Individual Record window opens. Enter the correc
parent (if known) in the Father or Mother field.

3. Type your child’s given name before the surname in the name field 
complete the rest of the information. (For additional information on 
editing children, see “Changing Parents” on page 53.)

Adding a Sibling
The Siblings window lists all siblings of the subject, including half-siblings

1. From a child’s Individual Record window click the Sibling button at th
bottom of the window to add a brother or sister. A new Individual 
Record window opens for your child’s brother or sister with the sibling
surname already entered, along with your name and your spouse’s n
in the parent fields.

2. Complete the sibling’s name field and the rest of the Individual Reco

Note To use the Sibling button on the Individual Record, you must 
have entered a parent. If you do not know the parents for a group of
lings, enter a name for the father or mother in one of the parent field
For example, for an individual named John Smith, you could enter a 
father or mother named Unknown /Smith/, or (-----) /Smith/. See “Add-
ing Parents” on page 27 of the Ultimate Family Tree User’s Guide for 
more information.

You have just entered three generations of individuals in your projec
and familiarized yourself with the Individual Record window. Now you can
view your data.

Viewing Ancestors in the Family Tree (Pedigree) Window
1. From the View menu, choose Family Tree to open the Family Tree w

dow, which is also known as a Pedigree chart.

2. To locate an individual, choose Locate from the Search menu or pre
-L to open the Find Individual window. Type the number 1 and pres

Return (or click Find) to find your name. Click OK.
The Family Tree window opens with your name in the focus pos

tion with generation 1 displayed beneath it. You can view up to five g
erations of a family at once. Your children are listed at the top left and
you have entered any of your siblings, they are listed at the bottom l
A plus (+) sign to the left of a name in the Child or Sibling window 
means that this person has descendants.
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The generation number changes depending on the generation o
focus person in relation to the original starting person displayed at th
upper left of the Family Tree window.

3. Double-click your name in the upper-left corner of the window to brin
yourself back to the focus position. Click Close to close the window.

Viewing a Family Group
1. From the View menu, choose Family Group. The husband and his p

ents (if known) are displayed at the top, the wife and her parents are
played in the center, and their children appear at the bottom of the 
window.

2. To change the focus of the window, click the Parents button to move
your parents into the Husband and Wife fields. Select a child in the 
Child list box and click the Child button to change the focus to that 
child.

3. Select your name and click Close to close the window.

Viewing an Individual Summary
1. From the View menu, choose Individual Summary to view all the info

mation recorded about yourself. This window can be sized smaller o
larger for ease of reading.

Note Some event details are displayed twice when viewing an Indiv
ual Summary. Because the Individual Summary shows a summary o
the information entered for an event, it displays the text that will be 
printed in the report as well as the basic data entered in the detail fie

Figure 2-15: Family Tree (Pedigree) Window

Focus person

Scroll down to
other siblings

Return focus to
previous subject

Switch to
spouse’s Family 

When green,
indicates that
line continues

Tree
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What you see as a duplicate detail on the computer screen will not p
in your report.

2. Scroll through the text to review the information you entered.

3. Close the window by clicking the Close box or by pressing Escape.

Figure 2-16: Family Group Window

View parent’s View any 

Number 

Family Groupadditional 
spouses

of children

Figure 2-17: Individual Summary Window

Close box

Scroll 
through text
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If you have entered data for your family during this tutorial session, y
can now add to it. If you would like to delete this tutorial project and start 
anew, follow the steps in the next section.

Deleting a Project
1. Choose Delete Project from the File menu. A warning window open

with this message, “ARE YOU SURE? ### records will be PERMA-
NENTLY deleted if you choose OK.”

2. Click OK.

3. Another window appears with this message, “ARE YOU SURE? Thi
project will be PERMANENTLY erased if you choose OK.” Click OK.

Did You Know?
There are some important features and short cuts built into Ultimate Fam
Tree designed to make entering your data easy. Read through this section
description of some of these features. See “Frequently Asked Questions”
the Appendix of the Ultimate Family Tree User’s Guide for answers to com-
mon questions.

Go Menu
The Go menu has two functions. It gives you the ability to move through l
and to quickly return to recently edited records. Choose Top to move to th
first person in the project. Choose Bottom to move to the last person. Cho
Up List or Down List to move to the next person in the list. The person’s p
tion in the list is determined by the order in which you last selected and 
viewed an individual list. If the last list you opened resulted from a search,
focus will change to those individuals in the search list.

Figure 2-18: Delete Project Warning



DID  Y OU K NOW? 5 3

ou 
 of 
di-

nt(s) 
 

 
 

 the 

 
it is 
 
 

This 
win-
ew 

nu. 

 
ven 
t 
Up to ten individual names are displayed in the Go List. Each time y
open an Individual Record, the name of that individual is moved to the top
the list. From the Go menu, choose any name in the list to return to that in
vidual’s record.

Changing Parents
In the course of your research, you may find that you have the wrong pare
attached to a child’s record. To change a parent for a person, follow these
steps:

1. From the Build menu, choose Individual Record.

2. To find the individual whose parent(s) you want to change, click the
main Name field, and click the Find button to the right of the Spouse
field.

3. Scroll through the list by pressing the first letter of the given name of
person you want to find.

4. Select the name and click OK.

5. Highlight the entire name of the parent you want to change.

6. Press the Delete key on the keyboard.

7. Choose Save from the File menu to save this record.

Note If you attempt to change the parent before saving the record,
you’ll get a message stating what the person’s name was and what 
now. You are asked if this is the same person or a new individual. To
avoid confusion, save the record after deleting the wrong parent and
before entering the correct parent name.

8. Enter the correct parent by following the steps on page 27.

The New Spouse Button
To enter a new spouse for an individual, choose the New Spouse button. 
button automatically creates a new marriage event. An Individual Record 
dow opens allowing you to enter the name and other information for the n
spouse. You can return to the first spouse by clicking the S button to the right 
of the name on the Spouse field or by selecting the name from the Go me
The marriage information can be entered in either record.

If the spouse is already in the project, choose New Event rather than
New Spouse. Select Marriage from the list and type the first part of the gi
name in the Spouse field. Click Find to open the Candidate Individuals lis
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with individuals whose names begin with the letters you typed in the list. 
Select the name and click OK. If you type the complete name instead of 
choosing Find, a message appears when you save the record asking if th
son is an existing person from the list. If so, click List. If it is a new person
click New.

Changing a Spouse in a Marriage Event
In the course of your research, you may find that you have the wrong spo
attached to a marriage record. To change a spouse, follow these steps:

1. Open the Individual Record for the person who is correctly connecte
the marriage event.

2. Click the numbered button to the left of the marriage event you wan
edit. This will open the Events window.

3. Highlight the name in the Spouse field and press the Delete key on 
keyboard to remove the spouse.

4. Click Save from the File menu.

5. Type the spouse’s name in the Spouse field. If the spouse is already
your project, enter a partial name (or simply highlight -unknown-) and 
click the Find button to open the Candidate Individuals list. Highlight
the name and click OK.

Note If you enter a full name in the Spouse field for an individual th
has already been entered in Ultimate Family Tree, a message appe
when the Individual Record is being saved stating that this name ha
already been entered. If it is a different person, click New. If the pers
has already been entered, highlight the person’s name and click Lis
link that individual. If you want to make changes, click Cancel to retu
to the Individual Record window. 

Text and Evidence Status Boxes
Event text and evidence can be added in the Events window or in the Ind
ual Record window. Two columns to the right of the Event Place field in th
Individual Record window contain Text and Evidence status boxes. Click 
Text or Evidence status box to open the associated window. An X in the status 
box indicates that data is present.

Click the numbered button next to an event name to open the Event
window where you can choose the Text or Evidence button to enter additi
information.
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Using Undo
If you click the New Individual, New Spouse, New Child, or New Sibling bu
ton and decide not to create the new record, choose Undo from the Edit m
to delete the record and return to the previous record.

Note Undo is not available if the record has been saved. As you en
information, the record is saved automatically. To delete a saved rec
from the File menu, choose Delete Record.

Date Preferences
You can specify the date format for the free-form date field. Set your prefe
ence to have dates display and print exactly as you’ve entered them or se
date format default such as 12 JUL 1943.

From the Utilities menu, choose Desktop Preferences, and then Mis
laneous from the submenu. Scroll through the date options and select the
mat you want. If you select any option other than “As entered,” modifiers w
be converted to full words in the free-form date field, such as ABT to about. 
Dates entered before selecting a date preference are unchanged.

Graphics Display
Ultimate Family Tree provides two styles for desktop display, custom graph
and Macintosh Desktop Colors. The custom graphics mode can reduce th
performance of the program. If you suspect that Ultimate Family Tree is r
ning more slowly than it should, switch to the Macintosh Colors mode.

From the Utilities menu, choose Desktop Preferences and then Misc
laneous from the submenu. Choose Use Macintosh Desktop Colors to ch
to Macintosh colors. Restart Ultimate Family Tree to complete the change

When you open certain windows while in the graphics mode, the me
sage, “Picture colors may be incorrect. Do you wish to use Macintosh Co
ors?” may appear. Choose No to ignore the message and open the windo
Choose Yes to change the desktop display to Macintosh Colors. Exit and 
restart Ultimate Family Tree to change to Macintosh colors. This message
appear if your graphics monitor is set to 256 colors. If your monitor is set 
16 colors, the Macintosh Colors are used.

Editing Place Names
If you want to edit or combine place names, create a new Individual Reco
for a temporary person. Select “an unknown location” on the birth event fi
and click the Find button. A list of all places in the Place Library is display
Scroll through the list to find place records you want to edit. Highlight a pla
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name and click OK. Edit the place name and choose Save from the File m
or press -S. A message appears stating that the place name has been 
changed. Click OK to save the spelling change. Because the Place Librar
common to all projects, changing the spelling will change it globally throu
out the open project and all other projects.

To edit another place, highlight the place name in the Individual Rec
and press the Delete key. Choose Save from the File menu and then click
Find button to reopen the Place List. Select another place from the list.

Note See page 161 of the Ultimate Family Tree User’s Guide for 
information on combining duplicate place names.

When you have finished editing place names, choose Delete Recor
from the File menu to delete this temporary record from the project.

Finding Individuals
There are several ways to find new subjects for the Individual Record wind
besides using the Find Individual window.

• Put the cursor in the main name field in the Individual Record windo
and click the Find button to the right of the spouse field to open a lis
all individuals in the project. The list is alphabetical by given name. 
Press any letter on the keyboard to move to the given names in the 
which start with that letter. Select a name and click OK to edit that p
son’s record.

• To choose a name from the Individual List, from the View menu, choo
Individual List, then By Surname from the submenu. Scroll through t
list and double-click a name to open the Individual Record for that p
son.

• From the Go menu, choose any name to move to that person’s Indiv
ual Record. Up to ten of the last individuals edited are displayed in t
Go list.

Note See page 76 of the Ultimate Family Tree User’s Guide for infor-
mation on using the Find Individual window.



DID  Y OU K NOW? 5 7

di-
e 
dy 
y 
al. 
rd 
Using Existing Records for Parent and Spouse Fields
If you enter a full name in either the parents or the Spouse fields for an in
vidual that has already been entered into Ultimate Family Tree, a messag
appears when the window is being saved stating that this name has alrea
been entered. If it is a different person, click New. If the person has alread
been entered, highlight the person’s name and click List to link that individu
If you want to make changes, click Cancel to return to the Individual Reco
window.
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